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(A405505) IT WORKSHOP 

(Common to CSE, ECE, IT, CSE-DS, CSE-AI&ML, AI&ML, AI&DS, CSE-CS) 

 

B.Tech II Semester   B.Tech (CSE) R22     L   T   P   C 

 0 0  3  1.5 

Course Objectives: 

• To impart the knowledge of various hardware components of a computer 

• To provide the skill of assembling the computer. 

• To impart the knowledge and usage of various Microsoft tools such as Power Point ,Word and Excel 

Course Outcomes 

Students shall be able to: 

CO-1. Identify various hardware components of a system and their significances 

CO-2. Assemble and disassemble the computer. 

CO-3. Use various Microsoft tools for text processing, visual presentations, and number crunching 

CO-4. Retrieve the information from Internet using web browsers. 

CO-5. Safeguard the system from external and internal threats. 
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ITWORKSHOP SYLLABUS 

PC Hardware 

Task 1: Identify the peripherals of a computer, components in a CPU and its functions. Draw the block 

diagram of the CPU along with the configuration of each peripheral and submit to your instructor. 

Task 2: Every student should disassemble and assemble the PC back to working condition. Lab 

instructors should verify the work and follow it up with a Viva. Also students need to go through the 

video which shows the process of assembling a PC. A video would be given as part of the course content. 

Task 3: Every student should individually install MS windows on the personal computer. Lab instructor 

should verify the installation and follow it up with a Viva. 

Task 4: Every student should install Linux on the computer. This computer should have windows 

installed. The system should be configured as dual boot with both Windows and Linux. Lab instructors 

should verify the installation and follow it up with a Viva. 

Internet & World Wide Web 

Task1: Orientation & Connectivity Boot Camp: Students should get connected to their Local Area 

Network and access the Internet. In the process they configure the TCP/IP setting. Finally students should 

demonstrate, to the instructor, how to access the websites and email. If there is no internet connectivity 

preparations need to be made by the instructors to simulate the WWW on the LAN. 

Task 2: Web Browsers, Surfing the Web: Students customize their web browsers with the LAN proxy 

settings, bookmarks, search toolbars and pop up blockers. Also, plug-ins like Macromedia Flash and JRE 

for applets should be configured. 

Task 3: Search Engines & Netiquette: Students should know what search engines are and how to use the 

search engines. A few topics would be given to the students for which they need to search on Google. 

This should be demonstrated to the instructors by the student. 

Task 4: Cyber Hygiene: Students would be exposed to the various threats on the internet and would be 

asked to configure their computer to be safe on the internet. They need to customize their browsers to 

block pop ups, block active x downloads to avoid viruses and/or worms. 

LaTeX and WORD 

Task 1 – Word Orientation: The mentor needs to give an overview of LaTeX and Microsoft (MS) office 

or equivalent (FOSS) tool word: Importance of LaTeX and MS office or equivalent (FOSS) tool Word as 

word Processors, Details of the four tasks and features that would be covered in each, Using LaTeX and 

word – Accessing, overview of toolbars, saving files, Using help and resources, rulers, format painter in 

word. 
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Task 2: Using LaTeX and Word to create a project certificate. Features to be covered: - Formatting Fonts 

in word, Drop Cap in word, Applying Text effects, Using Character Spacing, Borders and Colors, 

Inserting Header and Footer, Using Date and Time option in both LaTeX and Word. 

Task 3: Creating project abstract Features to be covered:-Formatting Styles, Inserting table, Bullets and 

Numbering, Changing Text Direction, Cell alignment, Footnote, Hyperlink, Symbols, Spell Check, Track 

Changes. 

Task 4: Creating a Newsletter: Features to be covered: - Table of Content, Newspaper columns, Images 

from files and clipart, Drawing toolbar and Word Art, Formatting Images, Textboxes, Paragraphs and 

Mail Merge in word. 

Excel 

Excel Orientation: The mentor needs to tell the importance of MS office or equivalent (FOSS) tool Excel 

as a Spreadsheet tool, give the details of the four tasks and features that would be covered in each. Using 

Excel –Accessing, overview of toolbars, saving excel files, Using help and resources. 

Task 1: Creating a Scheduler - Features to be covered: Gridlines, Format Cells, Summation, auto fill, 

Formatting Text 

Task 2: Calculating GPA - Features to be covered: - Cell Referencing, Formulae in excel – average, std. 

deviation, Charts, Renaming and Inserting worksheets, Hyper linking, Count function, 

LOOKUP/VLOOKUP 

Task 3: Split cells, freeze panes, group and outline, Sorting, Boolean and logical operators, Conditional 

formatting 

PowerPoint 

Task 1: Students will be working on basic power point utilities and tools which help them create basic 

PowerPoint presentations. PPT Orientation, Slide Layouts, Inserting Text, Word Art, Formatting Text, 

Bullets and Numbering, Auto Shapes, Lines and Arrows in PowerPoint. 

Task 2: Interactive presentations - Hyperlinks, Inserting –Images, Clip Art, Audio, Video, Objects, Tables 

and Charts. 

Task 3: Master Layouts (slide, template, and notes), Types of views (basic, presentation, slide slotter, 

notes etc), and Inserting – Background, textures, Design Templates, Hidden slides. 

REFERENCE BOOKS: 

1. Comdex Information Technology course tool kit Vikas Gupta, WILEY Dreamtech 

2. The Complete Computer upgrade and repair book, 3rd edition Cheryl A Schmidt, WILEY Dreamtech 

3. Introduction to Information Technology, ITL Education Solutions limited, Pearson Education. 

4. PC Hardware - A Handbook – Kate J. Chase PHI (Microsoft) 
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5. LaTeX Companion – Leslie Lamport, PHI/Pearson. 

6. IT Essentials PC Hardware and Software Companion Guide Third Edition by David Anfinson and Ken 

Quamme. –CISCO Press, Pearson Education. 

7. IT Essentials PC Hardware and Software Labs and Study Guide Third Edition by Patrick Regan– 

CISCO Press, Pearson Education. 

**END** 
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PC Hardware 

Task 1:  

AIM: Identify the peripherals of a computer, components in a CPU and its functions. Draw 

the block diagram of the CPU along with the configuration of each peripheral and submit 

to your instructor. 

INTRODUCTION TO COMPUTER: 

Computer is an electronic device which takes the input information from the input device and 

generates the output information and it will be displayed on the output. 

It enables arithmetic computations, data processing, information management (storage) and 

knowledge reasoning in an efficient manner. 

The word computer is derived from the word compute which means ‘to calculate’. So a 

computer generally considered to be calculating device that perform operations at very faster 

rates. 

BLOCK DIAGRAM OF COMPUTER 

 

 

 

 

 

 

 

 

 

 

Basically the computer system has three major components. These are 

 

• System Unit 
Central Processing Unit (Processor) 

Memory Unit.(Main memory and Auxiliary storage). 

• Input Unit. 

• Output Unit. 
Peripherals of a computer:  

1. Cabinet: 
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 It is used to install all hardware devices like (mother board, SMPS,HDD, CD Rom, FDD)  

 It has Start, Restart Button, Led’s, Audio and USB Connecters are available at front side.  

 

2. Monitor: 

A computer monitor is an output device that displays information in pictorial or textual 

form. 

There are several types of monitors; some are as follows: 

Cathode Ray Tube (CRT) Monitors. It is a technology used in early monitors. 

In the monitor the screen will be displayed in pixels format. 

  i. 800 by 600 pixels 

ii.1024 by 768 pixels 

Flat Panel Monitors. These types of monitors are lightweight and take less space.  

Touch Screen Monitors.  

LED Monitors. 

OLED Monitors. 

DLP Monitors. 

TFT Monitors. 

Plasma Screen Monitors. 

 
 

3. Key Board: 

 Key board is like a type writer, which contains keys to feed the data or information into the 

computer 

Keyboards are available in two modules. These are 

 standard key board with 83-88 keys 

 enhanced key board with 104 keys or above 
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4. Mouse: 

Every mouse has one primary button (left button) and one secondary button (right button). 

The primary button is used to carry out most tasks, where as secondary button is used in special 

cases you can select commands and options. 

 

 
5. Printer: 

A device that prints images (numbers, alphabets, graphs, etc…) on paper is known as Printer. 

We have different types of printers to take printouts. These are as follows: 

i. Dot matrix printer ii. Inkjet printer 

 

 

 

6. Speakers: 

Speakers make your system much more delightful to use entertain you while you are working on 

computer 
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7. Scanner: Scanner used to scan images and text. 

 

 
 

 

8. System board/Motherboard 

This is the major part of the PC hardware 

It manages all transactions of data between CPU peripherals. 

which holds the Processor, Random Access Memory and other parts, & has slots for expansion 

cards 

 It is rectangle shape 
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9. Socket 478: 

It use 478 – PIN MICROPGA package it is used installing CPU 

It is square type design. 

 

 

 

10. CPU 

 The central processing unit contains the heart of any computer, the processor. The processor 

is fitted on to a Mother Board. The Mother Board contains various components, which 

support the functioning of a PC. 

 It is brain of the computer 

It is square shape 

 
 

11. Ram Slots: 

Ram slots are used to install the rams 

It is large rectangle shape and each ending has small clips. 

There two type ram slots 

 SD Ram -Two Gaps (synchronous DRAM) is a generic name for various kinds of 

dynamic random access memory (DRAM) that are synchronized with the clock speed 
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that the microprocessor is optimized for. This tends to increase the number of instructions 

that the processor can perform in a given time. 

 DDR Ram -One Gap (Double Data Rate Synchronous DRAM: A clock is used to read 

data from a DRAM. DDR memory reads data on both the rising and falling edge of the 

clock, achieving a faster data rate.) 

 

 

 

 

 
 

12. North Bridge: 

 It is also called as controller 

It is nearby socket 478 

It placed middle of the mother board 

It converts electronic signals to binary values and binary values to electronic signals 

 

 
 

13. South Bridge: 

It is controls major components mother board and it back bone of the input out devices 

It is communicates PCI slots, IDE-1, IDE-2, floppy connecter, BIOS chip. 

It nearby CMOS battery 
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14. CMOS Battery: 

Computer is using a coin shape battery 

It generates the clock signal and it manage system continues time. 

 
 

15. Primary & Secondary (IDE-1 & IDE-2): 

It is also called as IDE-1, IDE-2. 

It used to connecting Hard Disk Drive, CD ROM, DVD ROM. 

 
 

16. Input & Output ports: 

 IO ports are used to connecting IO device such as key boards, mouse, monitor, printer, scanner, 

speakers etc... 
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17. AGP Slot & AGP Card: 

AGP Slot is used install the AGP card. 

AGP back view same as VGA port (15-female pins) and used to connecting the monitor’s  

This slot is above PCI slots and its color is Black or Brown 

 

 

 

18. CI Slots &PCI (Expansion) Cards: 

 PCI slots are used to install the PCI cards such as 

i. LAN (Ethernet) Card---Back view Ethernet port 

ii. Sound Card- Back view Audio pin connectors) 

iii. TV Tuner (Internal) Card - Dish Pin connecter 

iv. PCI Slots are white or yellow color 

v. PCI Card has Single gap only 
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19. BIOS Chip: 

 BIOS controls how the operating system and hardware work together 

 BIOS identification is BIOS name is available on chip or mother board 

 

 

 
 

20. ATX Power connecter: 

 ATX power connecter is used to connect ATX power plug (This is from SMPS) 

 It is white color and it has ATX Name is available on Mother Board 

 ATX Power connecter has 20/24 pins available. 

 Typical ATX 1.3 power supply. From left to right, the connectors are 20-pin motherboard, 4-

pin"P4connector", fan RPM monitor (note the lack of a power wire), SATA power connector 

(black),"Molex connector" and floppy connector. 

 

 
21. Floppy connecter: 

 Floppy connecter is used to connect Floppy Disk Drive. 

 This is beside of ATX power connecter and Name FDD is available on the mother board. 
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22. Bus Cables or Data cables: 

 A Bus is a collection of wires through which data is transmitted from one device to another 

device cables are two types 

 IDE cable: it used to connect HDD, CD ROM, DVD ROM 

 FDD cable: it used to connect FDD (braking or manufacture defecting) 

 

 
23. Hard Disk Drive: 

 The hard disk drive is the main, and usually largest, data storage device in a computer 

 The operating system, software titles and most other files are stored in the hard disk drive 

 Identifications is the panel name is Hard Disk drive 

 

 

  
 

24. CD ROM Drive & CD-Writer: 

 CD-Rom (Compact Disk Read only Memory) Drive is a device that reads the information 

from Compact Disks (CD). 

 CD-Writer is used to write the data into Compact Disk 

 Identification is the panel name is CD Writer 
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25. Floppy Disk Drive: 

 The floppy disk drive is used to read the information stored in floppy disks. 

 Floppy disks also called as a diskette. 

 Identification is smaller than CD Writer. 

 

 
 

26. SMPS: 

 SMPS is used to supply the power to Mother Board HDD,CD ROM, FDD 

 In SMPS holds a transformer, voltage control and fan 

 Identification is the rectangular box shape and panel name is switching mode power supply. 
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Task 2: Every student should disassemble and assemble the PC back to working condition. 

Lab instructors should verify the work and follow it up with a Viva. Also students need to 

go through the video which shows the process of assembling a PC. A video would be given 

as part of the course content. 

1. Setting the Cabinet ready:- 

 Check how to open the cabinet and determine where to fix the components. 

 Determine if the case has the appropriate risers installed. 

 

2. Fitting the Mother board. 

 Line up the patch on the motherboard (ps/l, USB, etc ) with the appropriate holes in the block 

panel I/O shield of the case. 

 Check the points where you and to install 

 Install them and make the mother board sit on them and fix screws if required. 

 

3. Installing the CPU 

 Raise the small lever at the side of the socket. 

 Notice that there is a pin missing at one corner, determine the direction to fit in the processor. 

 You should not force the CPU. When inserting it. All pins should slide smoothly into the 

socket. 

 Lock the lever back down. 

 

4. Installing CPU fan 

 Install the heat sink over it (Different type for each processor). Heat sink/CPU fan. 

 

5. Fitting the RAM: 

 The RAM must be suitable for motherboard. 

 There are currently 3 types of RAM available. 

SD RAM. 

DDR SD RAM. 

RD RAM. 

 The mother board‘s chipset determines which type of RAM may be used. 

 

6. Installing SMPS 

 

7. Installing the ATX Power Connector 

ATX Connectors: 

 PS, Mouse. 

 Key board. 

 USB. 

 Parallel ( Prints ) 

 Serial COM1. 

 Serial COM 2. 

 Joystick. 

 Sound. 
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8. Installing the HDD and Floppy disk: 

 Place the floppy and hard disks in their slots. 

 Leave some space above HDD to prevent heat building. 

 Check the jumper configuration. 

 Fix the screws. 

 

9. CD ROM Drive : 

 CD-ROM drive is similar to installing a hard disk. 

 1st check that the jumper configuration is correct. 

 Fix the screw. 

 

10. LAN Card 

 

11. Connecting the ribbon Cables and Front panel connections 

 Attach the long end of the cable to the IDEU connector on the motherboard first. The red 

stripe on the IDE cable should be facing the CD Power. 

 

12. Final Check: 

 Mother board jumper configurations are the settings for the processor operator. 

 Drive jumper settings, master/ slave correct? 

 Is the processor, RAM modules and plug in cards finally seated in their sockets? 

 Did you plug all the cables in? Do they all fit really? 

 Have you frightened all the screws in plug- in cards or fitted the clips? 

 Are the drive secure? 

 Have u connected the power cables to all driver? 

 

Powering up for the first time: 

1. Ensure that no wires are touching the CPU heat sink fan. 

2. Plug your monitor, mouse and keyboard. 

3. Plug in power card and switch the power supply. 

4. If everything is connected as it should be 

 All systems, fans should start spinning 

 You should hear a single beep and after about 5-10 sec 

 Amber light on monitor should go green 

 You will see computer start to boot with a memory check 

 Now check front LED‘S to see if u plugged them in correctly 

 Check all other buttons 

 Power afford change any wrong settings 

 

TEST DATA: No Test Data for This Experiment 

ERROR: No Errors for this Experiment 

RESULT: Assembling and disassembling the system is completed 
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Task 3: Every student should individually install MS windows on the personal computer. Lab 

instructor should verify the installation and follow it up with a Viva. 

AIM: To install Windows XP 

Software Requirement: Windows XP Compact Disc  

Hardware Requirement: Personal computer 

 

PROCEDURE: 

1. Keep on press the delete button and go to advanced BIOS feature [ BIOS- Basic Input Output 

System ] 

2. And go to boot sequence. Select first boot drivers. CD ROM and press F10 to save the bios 

feature. Yes and then enter. Press any key to boot from CD. Press enter to setup windows XP. 

F8 = To agree the license. 

3. Press ESC to don‘t repair the windows XP setup. 

4. Press ‗p‘to delete the previous partitions. Then press enter. 

5. Press ‗L‘to delete the partition. 

6. Press ‗C‘to create the partition in the UN partition space. 

7. Press enter to setup windows XP on the selected items. 

BASIC FILE SYSTEMS: 

FAT: File Allocation Table. 

NTFS: New Technology File System. 

Format the create using NTFS partition. 

BASIC STEPS IN INSTALLATION:- 

1. Collecting information. 

2. Dynamic update 

3. Preparing installation 

4. Installing windows. 

5. Tracking installation 

Screen shots of windows XP Installation 

1. Insert the Windows XP CD into your computer and restart your computer. If prompted to 

start from the CD, press SPACEBAR. If you miss the prompt (it only appears for a few 

seconds), restart your computer to try again. 
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2. Windows XP Setup begins. During this portion of setup, your mouse will not work, so you 

must use the keyboard. On the Welcome to Setup page, press ENTER. 

 
 

3. On the Windows XP Licensing Agreement page, read the licensing agreement. Press the 

PAGEDOWN key to scroll to the bottom of the agreement. Then press F8. 

 
 

4. This page enables you to select the hard disk drive on which Windows XP will be installed. 

Once you complete this step, all data on your hard disk drive will be removed and cannot be 

recovered. It is extremely important that you have a recent backup copy of your files before 

continuing. When you have a backup copy, press D, and then press L when prompted. This 

deletes your existing data. Press ENTER to select Unpartitioned space, which appears by 

default. 
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5. Press ENTER again to select Format the partition using the NTFS file system, which 

appears by default. 

 
 

6. Windows XP erases your hard disk drive using a process called formatting and then copies 

the setup files. You can leave your computer and return in 20 to 30 minutes. 
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7. Windows XP restarts and then continues with the installation process. From thispoint 

forward, you can use your mouse. Eventually, the Regional and LanguageOptions page 

appears. Click next to accept the default settings. If you are multilingual or prefer a language 

other than English, you can change language settings after setup is complete. 

 
 

8. On the Personalize Your Software page, type your name and your organization name. Some 

programs use this information to automatically fill in your name when required. Then, click 

Next. 
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9. On the Your Product Key page, type your product key as it appears on your Windows XP 

CD case. The product key is unique for every Windows XP installation. Then, click Next. 
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10. On the Computer Name and Administrator Password page, in the Computer name box, 

type a name that uniquely identifies your computer in your house, such as FAMILYROOM 

or TOMS. You cannot use spaces or punctuation. If you connect your computer to a network, 

you will use this computer name to find shared files and printers. Type a strong password 

that you can remember in the Administratorpassword box, and then retype it in the 

Confirm password box. Write the password down and store it in a secure place. Click Next. 

 
 

11. On the Date and Time Settings page, set your computer‘s clock. Then, click the Time Zone 

down arrow, and select your time zone. Click Next. 
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12. Windows XP will spend about a minute configuring your computer. On the Networking 

Settings page, click Next. 
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13. On the Workgroup or Computer Domain page, click Next. 

 
 

14. Windows XP will spend 20 or 30 minutes configuring your computer and will automatically 

restart when finished. When the Display Settings dialog appears, click OK 

 
 

15. When the Monitor Settings dialog box appears, click OK. 
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16. The final stage of setup begins. On the Welcome to Microsoft Windows page, click Next. 

 
 

17. On the Help protect your PC page, click Help protect my PC by turning on Automatic 

Updates now. Then, click 

 
 

18. Windows XP will then check if you are connected to the Internet: If you are connected to the 

Internet, select the choice that describes your network connection on the Will this computer 

connect to the Internet directly, or through a network?Page. If you‘re not sure, accept the 

default selection, and click Next 
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19. If you use dial-up Internet access, or if Windows XP cannot connect to the Internet, you can 

connect to the Internet after setup is complete. On the How willthis computer connect to 

the Internet? Page, click Skip. 

 
 

20. Windows XP Setup displays the Ready to activate Windows? Page. If you are connected to 

the Internet, click Yes, and then click Next. If you are not yet connected to the Internet, click 

No, click Next, and then skip to step 24. After setup is complete, Windows XP will 

automatically remind you to activate and register your copy of Windows XP 
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21. On the Ready to register with Microsoft? Page, click Yes, and then click Next. 

 
 

22. On the collecting registration information page, complete the form. Then, click Next. 

 
 

23. On the Who will use this computer? page, type the name of each person who will use the 

computer. You can use first names only, nicknames, or full names. Then click Next. To add 
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users after setup is complete or to specify a password to keep your account private, read 

Create and customize user accounts. 

 
 

24. On the Thank you! Page, click Finish. Congratulations! Windows XP setup is complete. 

 
 

TEST DATA: No Test data for this Experiment 

ERROR: No Errors for this Experiment 

RESULT: Installation of Windows XP is completed. 
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Task 4: Every student should install Linux on the computer. This computer should have windows 

installed. The system should be configured as dual boot with both Windows and Linux. Lab 

instructors should verify the installation and follow it up with a Viva. 

Software Requirement: Linux Compact Discs 

Hardware Requirement: Personal computer 

PROCEDURE: 

 

1. Language Selection 

Using your mouse select the language you would prefer to use for theinstallation Click next to 

continue.  

 

2. Key Board Configuration: 

Using your mouse select the correct layout type for the keyboard youwould prefer to use for the 

installation and as the system default. Once you have made the selection click next to continue. 

 

3. Mouse Configuration: 

 If you have a PS/2, USB or Bus mouse you do not need to pick a port and device. If you have a 

serial mouse, you should choose the correct port and device that your serial mouse is on. The 

Emulate 3 buttons checkbox allows you to use a two-button mouse as if it had three buttons. If 

you select this check box you can emulate a third ―middle button by pressing both mouse 

buttons simultaneously. 

 

4. Installation Type: 

Choose the type of installation you would like to perform.Your options are Personal desktop, 

Workstation, Server, Custom and upgrade. 

 

5. Disk partition Setup: 

 You can chose automatic partitioning or manual partitioning using Disk Druid of fdisk.  

 Automatic partitioning allows you to perform an installation without havingto partition your 

drives yourself.  

 Automatic partitioning allows you to have some control concerning whatdata is removed 

from your system. 

Your options are: 

 Remove all Linux partitions on this system. 

 Remove all partitions on this system 

Keep all partitions and use existing free space. 

 To partition manually choose either Disk druid or fdisk partitioning tool.  

 Tick next once you have made your selections. 

 

6. Partitioning your system: 

 If you chose automatic partitioning and did not select Review skip ahead  

 If you choose automatic partitioning and selected review you can either accept the current 

partition settings (click next) or modify the setup using Disk Druid, the manual partition 

tool. 

If you choose manual partition with disk skip ahead.  
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 At this point you must tell the installation program where to install Linux.  

 This is done by defining mount points for one ormore disk partitions in which Linux will be 

installed. 

7.Adding Partitions: 

 To add a new partition select new button, a dialogue box appears.  

 Select the options and click ok  

 

8. Boot Loader Configuration: 

 Boot loader is the first software program that runs when a computer starts. 

 The installation program provides two boot loaders GRUB ( GR andUnified Boot Loader) 

which is the default and LILO 

 If you do not want GRUB as your boot loader click Change Boot Loader. 

 You can then choose to install LILO or choose not to install boot loader at all by clicking Do 

not install boot loader on the change boot loaderbutton.  

 Network devices are automatically detected and displayed in NetworkDevices list,  

 Select a network device and click Edit  

 Here you can configure IP address and net mask of the device.  

 

9. Firewall configuration: 

 Offers firewall protection for enhanced protection.  

 A properly configured firewall can greatly increase the security of the system. 

 

10. Time zone configuration: 

You can set your time zone by selecting your computers physical location or by specifying your 

time zones offset from Universal Time. 

 

11. Account Configuration: 

 Allows to set Root password or user accounts 

 Root count is similar to the administrator password that you set up in Win NT. 

 Click add button to add a new non-rot user.  

 Enter the details and click OK.  

 

12. Packing group selection: 

You can select package groups which groups components together or individual packages or a 

combination of the two. 

 

TEST DATA: No Test data for this Experiment 

ERROR: No Errors for this Experiment 

RESULT: Installing the OS of Linux is completed 
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Internet and WWW 

 
Task1: Orientation & Connectivity Boot Camp: Students should get connected to their 

Local Area Network and access the Internet. In the process they configure the TCP/IP 

setting. Finally students should demonstrate, to the instructor, how to access the websites 

and email. If there is no internet connectivity preparations need to be made by the 

instructors to simulate the WWW on the LAN. 

AIM: To learn Local Area Network and access the Internet. In the process theyconfigure the 

TCP/IP setting. Finally students should demonstrate, to theinstructor, how to access the websites 

and email 

 

Software Requirement: Local Area Network to access theInternet  

Hardware Requirement: Personal computer  

THEORY:The internet is a worldwide, publicly network of interconnected computernetworks 

 

LOCAL AREA NETWORK: 

LANs are privately owned networks with in a single building or campus of up tofew kilometers 

in size. 

WIDE AREA NETWORK: 

A WAN is a network that connects computers across a large geographic areasuch as a city or 

country 

TCP/IP(Transmission Control Protocol/Internet Protocol): 

Collection of methods used to connect servers on the internet and to exchangedata. 

HTML (Hyper Text Markup Language): 

The coding used t o control the look of documents on the web 

HTTP (Hyper Text Transfer Protocol): 

Part of a url that identifies the location as one that uses HTML 

IP (Internet Protocol): 

A format for contents and addresses of packets of information sent overthe internet 

IP ADDRESS: 

An identifier for a computer or device on a TCP/IP network 

SEARCH ENGINE: 

A program that searches documents located on the Internet for keywords orphrases entered by a 

person browsing the net. 

Internet Connection requirements: 

 TCP/IP protocol  

 Client Software  

 ISP Account  

Means of communication to the net: 

 Telephone Modem  

 Ethernet  

 ISDN(Integrated Services Digital Network)  

 DSL(Digital Subscriber Line)  

 Satellite. 
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PROCEDURE: 

1. Go to start>control Panel 

2. openNetwork Connections 

3. Click create a new connection and then click next 

4. The new connection wizard window opens , click next to continue 

5. Choose one of the options in the next dialog box 

6. Choose one of the three options in the next dialog box 

If you do not have an internet account click choose from a list of ISPs and then click next  

If you have an account click Set up my connection manually 

If you have a CD from the ISP click use the CD I got from an ISP and then click next  

7. Follow the next steps as per the option you selected. 

TEST DATA: No Test data for this Experiment 

ERROR: No Errors for this Experiment 

RESULT: In this way we can learn surfing the web. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



IT WORKSHOP LAB MANUAL 
 

CMRCET Page 35 
 

Task 2: Web Browsers, Surfing the Web: Students customize their web browsers with the 

LAN proxy settings, bookmarks, search toolbars and pop up blockers. Also, plug-ins like 

Macromedia Flash and JRE for applets should be configured. 

AIM: To learn to surf the web 

Software Requirement: Local Area Network to access the Internet 

Hardware Requirement: Personal computer 

THEORY: 

Web browser provides the means to the searching and also helps to Download the web content. 

Web browsers support most of the famous Internet Protocols like HTTP, FTP. 

Common file formats a browser accepts are HTML  

Well known browsers natively support a variety of other formats in addition to HTML such as 

JPEG,PNG,GIF image formats. 

Different web browsers available in the market are:  

 Silversmith 

 Mosaic 

 Netscape 

 Mozilla 

 Opera 

 Lynx 

 Safari 

Bookmark: 
Each web browser is built-in with the support of Internet Bookmarks which serve as a named 

anchor – primarily to URLs. The primary purpose of this book mark is to easily catalog and 

access web pages that the web browser user has visited or plans to visit, without having to 

navigate the web to get there. 

Pop-up Blockers: 

Pop-ups are a form of online advertising on the WWW intended to attract the attention of the 

users. These pop ups are hosted on the web sites which are frequently visited by the netizens. 

These pop ups are activated when these web sites open a new web browser window and there by 

displaying the advertisements. 

Plug-ins: 

A plug-in is a software component program that interacts with a main application to provide a 

better integration of the media. The basic difference between application programs and plug-ins 

is that multimedia files are launched in a separate window where as in plug-ins multimedia play 

in the browser window. 

Few famous plug -ins are: 

 Apple Quick Time 

 Macromedia flash 

 Microsoft Media Player 

 Adobe Shockwave 

 Sun Microsystems Java Applet  

PROCEDURE: LAN Proxy Settings: 

selecttools menu in Internet Explorer 

Select Internet Options 
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Select Connections 

You end up in two options 

Dial-up and virtual network settings 

LAN setting 
The selection at this step is dependent on the kind of connection you are trying to configure. 

They are: 

Dial-up modem connection 

LAN connection  

DSL or Cable modem 
TEST DATA: No Test data for this Experiment 

ERROR: No Errors for this Experiment 

RESULT: In this way we can learn surfing the web 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



IT WORKSHOP LAB MANUAL 
 

CMRCET Page 37 
 

Task 3: Search Engines & Netiquette: Students should know what search engines are and 

how to use the search engines. A few topics would be given to the students for which they 

need to search on Google. This should be demonstrated to the instructors by the student. 

AIM: To know what search engines are and how to use the search engines. 

Software Requirement: Local Area Network to access the Internet 

Hardware Requirement: Personal computer 

THEORY: 

Search engine: 

A search engine can be defined as a web site with tools which help you to find information on 

the internet 

Function of a search engine: 

You can find anything from a schedule of White house tours to instructions for removing stains 

from clothes. 

Limitations: 

Search engines visit web sites only several weeks. Search engines cannot see information in 

other data bases later on. On the internet a search engine is a coordinated set of programs that 

includes: A spider (crawler or bot) that goes to every page or representative pages on every web 

site that wants to be searchable and reads it , using hypertext links on each page to discover and 

read site‘s other pages. 

Pros: 

 You can select the search terms. 

 You can use the same search terms with multiple search engines. 

 You can change search terms as much as you wish. 

 You will normally receive numerous links. 

Cons: 

EX: Its fast 

There are so many different search engines it may be difficult to choose 

You will normally receive too many links often making it difficult to identify the most relevant 

sites. 

The vast majority of links may be only marginally relevant or altogether irrelevant 

Alta Vista 

Ask Jeeves 

Google 

Lycos 

Etc...  

Meta Search Engines: 

Meta search engines or ―metacrawlersǁ don‘t crawl the web themselves. Instead 

they search the resources of multiple search engines by sending a search to 

several search engines at once aggregating the result. 

Pros: 

 You only need to use one search tool which is time- efficient 

 You only need to learn how to use one search engine reducing learning curve 

 You benefit from the difference among several search tools at once 
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Cons: 

Meta search services may not be able to leverage each individual searchengines full range of 

query tools resulting in less refined searches 

You can not personally select the search engines queried by Meta search services. 

 

TEST DATA: No Test data for this Experiment 

ERROR: No Errors for this Experiment 

RESULT: In this way we can know what search engines are and how to use the search engines. 
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Task 4: Cyber Hygiene: Students would be exposed to the various threats on the internet 

and would be asked to configure their computer to be safe on the internet. They need to 

customize their browsers to block pop ups, block active x downloads to avoid viruses 

and/or worms. 

AIM: To learn various threats on the internet and configure the computer tobe safe on the 

internet. 

Software Requirement: Antivirus Software 

Hardware Requirement: Personal computer 

THEORY: 

Antivirus: 

Antivirus software is a program that either comes installed on your computer or that you 

purchase and install yourself. It protects your computer against most viruses, worms, Trojan 

horses and other unwanted invaders that can make your computer sick. 

Firewall: 

A firewall is a special software or hardware designed to protect a private computer network from 

unauthorized access. A firewall is a set of related programs located at a network gateway server 

which protects the resources of the private network from users from other networks. 

PROCEDURE: 

Installing Symantec antivirus for Windows: 

Insert Symantec antivirus CD into your CD drive  

Double click on the Symantec-setup.exe  

The installer will open  

Click next to proceed 

License agreement will open. Click I accept the terms of the license agreement and then click 

next. 

Follow the instruction on the screen to complete the installation. 

Get Computer Updates: 

Click start> settings>control panel 

Click Automatic Updates icon to open Automatic Updates dialog box 

Check the box Keep my computer up to date 

Choose a setting 

Click OK 

Block Pop ups: 

In the IE open tools>pop-up blocker 

Click on Turn on Pop- up blocker 

Windows Firewall: 

Go to Start>control panel>Network and Internet Connections >windows firewall 

In the general tab check the On(recommended) box 

If you don‘t want any exceptions check on Don’t allow exceptionsbox 

TEST DATA: No Test data for this Experiment 

ERROR: No Errors for this Experiment 

RESULT: Antivirus is installed in the system. 
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WORD & LATEX 

Task 1 – Word Orientation: The mentor needs to give an overview of LaTeX and Microsoft 

(MS) office or equivalent (FOSS) tool word: Importance of LaTeX and MS office or 

equivalent (FOSS) tool Word as word Processors, Details of the four tasks and features 

that would be covered in each, Using LaTeX and word – Accessing, overview of toolbars, 

saving files, Using help and resources, rulers, format painter in word. 

AIM: To maintain a shift schedule with specifications  

Software Requirement: MS-WORD and Latex 

Hardware Requirement: Personal computer  

THEORY:  
Rulers: It is used to change the format of the document, i.e. it helps you align the text, tables, 

graphics and other elements of your document.  

Format Painter: It is used to quickly apply the same formatting, such as color, font style and 

size, or border style, to multiple pieces of text or graphics.  

To choose Format Painter: On the Home tab, select Format Painter in the Clipboard group.  

Overview of toolbars:  
• Quick Access Toolbar lies next to the Microsoft Office Button.  

• It gives you quick access to commonly used commands such as Save, Undo, Redo, etc.  

Tabs:  

• It comprises seven tabs; Home, Insert, Page layout, References, Mailing, Review and View.  

• Each tab has specific groups of related commands. It gives you quick access to the commonly 

used commands that you need to complete a task.  

PROCEDURE:  
Step 1 : Click the start button which is located on the left-hand bottom corner on your Desktop or 

Laptop  

Step 2 : Click the All Programs button just above the Start button.  

Step 3 : Find the group Microsoft Office. If you point at the Microsoft Office group icon, the 

sub-group will open. If it does not, just click once with your left mouse button.  

Step 4 : In the sub-group, one of the icon will be Microsoft Office Word. 

 

For Latex: 

 All the commands in the Latex begin with the backslash' \.' 

 The first step is to open the Texmaker or TexStudio any corresponding editor you are using 

for the Latex. 

Symbols: 

 \ it is called backslash, used as the starting command.  

 {} it is called curly brackets, which is used to group and separate commands from its 

surroundings and must appear in pairs. 

 \\ terminates a line. 

 % commands lines. 

List: 

 The Latex lists are used to add any additional packages.  

 There are three types of lists.  
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One is the enumerate list, which produces the numbered list.  

The second is itemize, which is used for the bulleted lists.  

The third one is the description list, which is neither bulleted nor numbered.  

 In Latex, each list is defined by the \item. 

Syles: The styles are categorized into family, series, and shape.  

For color: \usepackage{xcolor} 

For Image:  \graphicspath{ {images/} }   

\includegraphics[width=6cm, height=4cm] 

{smiley}\\  The image of a smiley is given above.   

\caption{The Sun}   

 

TEST DATA: No Test data for this Experiment  

ERROR: No Errors for this Experiment  

RESULT: A word document is created by applying the above mentioned techniques. 
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Task 2: Using Word to create a project certificate. Features to be covered: - Formatting 

Fonts in word, Drop Cap in word, Applying Text effects, Using Character Spacing, 

Borders and Colors, Inserting Header and Footer, Using Date and Time option in  Word. 

 
AIM: To create a document applying the above mentioned techniques.  

Software Requirement: MS-WORD  

Hardware Requirement: Personal computer  

THEORY:  

Header and Footer: To create a header, enter text or graphics in the header area or click button 

on the header and footer tool bar. To create footer, click switch between header and footer. Then 

click exit.  

Date and Time: Insert a date field that automatically updates so that the current date is displayed 

when you open or print the file. Insert a time field that automatically updates so that the current 

time is displayed when you open or print the file.  

Border: On the format menu, click borders and shadings. To specify that the border appears on a 

particular side of a page, such as only at the top, click custom under setting. To specify a 

particular page or section for the borders to appear, click the option you want to apply. To 

specify the exact position of the border on the page. Finally, click OK.  

Color: Select the text you want to make a different color. To apply the color most recently 

applied to text, click font color. To apply different colors, click the arrow on the right of the font 

color button, select the color you want and then click the button.  

PROCEDURE:  

First click start button on the status bar. Then select program and again select Microsoft word. 

On the menu bar click the file option. Then again click new. Then enter the text not less than 100 

words. A header appears at the top and the footer appears at the bottom of each page. On the 

view menu, click header and footer option. From dialogue box, make the required changes and 

then click OK. On the format menu, click borders and shading s make required changes and the 

click OK. Select the text you want and make the different color. Click on right of the font color 

button, and then select the color you want and then click on the button.  

TEST DATA: No Test data for this Experiment  

ERROR: No Errors for this Experiment  

RESULT: A document is created by applying the above mentioned techniques. 
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Task 3: Creating project abstract Features to be covered:-Formatting Styles, Inserting 

table, Bullets and Numbering, Changing Text Direction, Cell alignment, Footnote, 

Hyperlink, Symbols, Spell Check, Track Changes. 

 

AIM: To create a document applying the above mentioned techniques.  

Software Requirement: MS-WORD  

Hardware Requirement: Personal computer  

Table: A table consists of rows and columns.  

Cell Alignment: Aligns contents written in a table in the top left corner or top right corner or in 

the centre etc...  

Foot Note:  Foot notes are used to comments on, or provide references for text in a document. 

Hyperlink: It is a colored and underlined text or a graphic that you click to go to a file, a 

location in a file, an HTML page on the World Wide Web, or an HTML page in an intranet.  

Symbols: You may not be able to enter certain symbols into your word document, as there is a 

limitation on the keys on the key board. Creating these new symbols especially when working 

with mathematical terms it becomes very difficult .For example we can insert symbols such 

as≡,≈, ,..  

Spell check: It automatically checks for spelling and grammatical errors  

Bullets and Numbering: In Microsoft word we can easily create bulleted or numbered list of 

items.  

Formatting Styles: A style is a set of rules to be followed for the effective document. Style can 

be applied to text, paragraph, table or a list.  

Changing text direction: You can change the text orientation in drawing objects, such as text 

boxes, shapes, and callouts, or in table cells so that the text is displayed vertically or horizontally.  

Track changes: A track change is an excellent feature of Microsoft word as it enables a user or 

reviewer to keep track of the changes that have taken a period. Changes like insertion, deletion or 

formatting changes can be kept track of.  

Procedure:  

Changing Text direction:  
1. Click the drawing object or table cell that contains the text you want to  change.  

2. On the Format menu, click Text Direction.  

3. Click the orientation you want.  

Table:  
1. Click where you want to create a table.  

2. On the Table menu, point to Insert, and then click Table.  

3. Under Table size, select the number of columns and rows.  

4. Under AutoFit behavior, choose options to adjust table size.  

5. To use a built-in table format, click AutoFormat.  

Select the options you want  

Cell Alignment:  

1. Click the cell that c obtains text you want to align.  

2. On the Tables and Borders toolbar, select the option for the horizontal and vertical alignment 

you want— for example, Align Bottom Center or Align Top Right.  

Foot Note:  

1. In print layout view, click where you want to insert the note reference mark.  

2. On the Insert menu, point to Reference, and then click Footnote.  
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3. Click Footnotes or Endnotes.  

By default, Word places footnotes at the end of each page and endnotes at the end of the 

document. You can change the placement of footnotes and endnotes by making a selection in the 

Footnotes or Endnotes box.  

4. In the Number format box, click the format you want.  

5. Click Insert. Word inserts the note number and places the insertion point next to the note 

number.  

6. Type the note text.  

7. Scroll to your place in the document and continue typing.  

As you insert additional footnotes or endnotes in the document, Word  

Automatically applies the correct number format.  

Hyper link: Select the text or picture you want to display as the hyperlink, and then click Insert 

Hyperlink on the Standard toolbar  

Do one of the following:  

1. Link to an existing file or web page:  

1. Under Link to, click Existing File or Web Page.  

2. In the Address box, type the address you want to link to or, in the Look in box, click the down 

arrow, and navigate to and select the file  

2. Link to a file you haven‘t created yet Under Link to, click Create New Document.  

3. In the Name of new document box, type the name of the new file.  

4. Under When to edit, click either Edit the new document later or Edit the new document now  

An e-mail address:  

1. Select the text or picture you want to display as the hyperlink, and then click Insert Hyperlink 

on the Standard toolbar  

2. Under Link to, click E-mail Address.  

3. Either type the e-mail address you want in the E-mail address box, or select an e-mail address 

in the recently used e-mail addresses box.  

4. In the Subject box, type the subject of the e-mail message  

A specific location in another document  

1. Insert a bookmark in the destination file or Web page.  

2. Open the file that you want to link from, and select the text or object you want to display as 

the hyperlink.  

3. On the Standard toolbar, click Insert Hyperlink . 

4. Under Link to, click Existing File or Web Page.  

5. In the Look in box, click the down arrow, and navigate to and select the file that you want to 

link to.  

6. Click Bookmark, select the bookmark you want, and then click OK.  

Symbol:  

1. Click where you want to insert the symbol. 

2. On the Insert menu, click Symbol, and then click the Symbols tab.  

3. In the Font box, click the font that you want.  

4. Double-click the symbol that you want to insert and Click Close.  

Spell check:  
1. O n the Standard toolbar, click Spelling and Grammar . 

2. When Word finds a possible spelling or grammatical problem, make your changes in the 

Spelling and Grammar dialog box.  
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Bullets and Numbering:  

1. Type 1. to start a numbered list or * (asterisk) to start a bulleted list, and then press 

SPACEBAR or TAB.  

2. Type any text you want.  

3. Press ENTER to add the next list item.  

Word automatically inserts the next number or bullet.  

4. To finish the list, press ENTER twice, or press BACKSPACE to delete the last bullet or 

number in the list  

Formatting Styles:  
1. Select the words, paragraph, list, or table you want to change.  

2. If the Styles and Formatting task pane is not open, click Styles and Formatting on the 

Formatting toolbar  

3. Click the style you want in the Styles and Formatting task pane. If the style you want is not 

listed, click All Styles in the Show box  

Track Changes:  
1. Open the document you want to revise.  

2. On the Tools menu, click Track Changes  

TEST DATA: No Test data for this Experiment  

ERROR: No Errors for this Experiment  

RESULT: A document is created by applying the above mentioned techniques.  
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Task-4  

Creating a Newsletter: Features to be covered:- Table of Content, Newspaper columns, 

Images from files and clipart, Drawing toolbar and Word Art, Formatting Images, 

Textboxes, Paragraphs in word.  
AIM :Create a news Letter  

Software Requirement: MS-WORD  

Hardware Requirement: Personal computer  

THEORY:  

Table of contents: Table of contents displays a list of headings in a created document. It 

basically provides an outline of the entire document created  

Newspaper columns: One can create a newspaper columns document by specifying the number 

of new letter-style column required and then adjust their width , and add vertical lines between 

columns.  

Images from files and clipart: Inserting a picture (graphic) from a file and clipart may be 

required for a document. This picture could be a scanned photograph or any other digitally 

produced one. This pictures can be modified, resized, cropped and enhanced.  

Drawing toolbar and Word Art: One can create his/her own drawings in Microsoft word. Ms 

Word provides a full-fledged drawing tool bar.  

Word Art in Microsoft word enables you to create special and decorative text.  

Formatting Images, Textboxes and Paragraphs: Formatting an image includes selecting 

appropriate color, size, layout and cropping. Generally the text in a document follows a standard 

orientation (line after line). A text box provides a different orientation to the text with in a 

document. It can arrange the text in anywhere and can be resized and moreover moved to any 

section of the document or even outside. When you are formatting a paragraph, you do not need 

to highlight the entire paragraph. Placing the cursor anywhere in the paragraph enables you to 

format it. After you set a paragraph format, subsequent paragraphs will have the same format 

unless you change the format  

PROCEDURE:  

Table of contents:  
1. Click where you want to insert the table of contents.  

2. On the Insert menu, point to Reference, and click Index and Tables.  

3. Click the Table of Contents tab.  

4. To use one of the available designs, click a design in the Formats box.  

5. Select any other table of contents options you want.  

Newspaper columns:  
1. Select the entire or part of document to be converted into a newsletter-style  

2. Click on format menu , select columns  

3. Any desired number of columns are presents-one or two or three or left or right b\can be 

selected.  

4. Width and spacing can be fixed and equal columns width can be checked for uniformity  

5. If newspaper columns are to be separated by a line, then check line between  

6. Under apply to will be whole document if entire document is selected else we have to select a 

selected text.  

7. Click ok  

Inserting images from files and clip art:  
1. Click where you want to insert the picture.  
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2. On the Insert menu, point to Picture, and then click From File.  

3. Locate the picture you want to insert.  

4. Double-click the picture you want to insert.  

CLIP ART:  

1. On the Insert menu, point to Picture, and then click Clip Art.  

2. In the Clip Art task pane, in the Search for box, type a word or  

phrase that describes the clip you want or type in all or some of the  

file name of the clip.  

To narrow your search, do one or both of the following: 

To limit search results to a specific collection of clips, in the Search in box, click the arrow and 

select the collections you want to search. To limit search results to a specific type of media file, 

in the Results should be box, click the arrow and select the check box next to the types of clips 

you want to find.  

4. Click Go.  

5. If you don't know the exact file name, you can substitute wildcard  

Characters for one or more real characters. Use the asterisk (*) as a substitute for zero or more 

characters in a file name. Use the question mark (?) as a substitute for a single character in a file 

name.  

6. In the Results box, click the clip to insert it.  

Drawing Toolbar and Word Art:  

1. Click in your document where you want to create the drawing.  

2. On the Insert menu, point to Picture, and then click New  

Drawing. A drawing canvas is inserted into your document.  

3. Use the Drawing toolbar to add any shapes or pictures that you want  

WORD ART:  
1.On the Drawing toolbar, click Insert WordArt .  

2.Click the WordArt effect you want, and then click OK.  

3.In the Edit WordArt Text dialog box, type the text you want.  

4.Do any of the following: 

To change the font Style, in the Style list, select a style 

 To change the font size, in the Size list, select a size.  

 To make text bold, click the Bold button.  

 To make text italic, click the Italic button.  

Formatting Images:  

1. Formatting of the images can be achieved by selecting the image and  

double click on the picture, format picture dialog box appears.  

2. The same can be achieved by selecting the tools menu > customize>tool bars tab>picture and 

click close.  

Basic formatting features of an image  

Resize a drawing  

1. Select the drawing canvas  

2. On the Drawing Canvas toolbar, do one of the following:  

To make the drawing canvas boundary larger without changing the size of the objects on the 

canvas, click Expand . 
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To make the drawing canvas boundary fit tightly around the drawing objects or pictures, click Fit  

To scale the drawing and make the objects and canvas proportionately smaller or larger, click 

Scale Drawing, and then drag the edges of the canvas.  

 

Resize a picture or shape  

1. Position the mouse pointer over one of the sizing handles  

2. Drag the sizing handle until the object is the shape and size you want. 

To increase or decrease the size in one or more directions, drag the mouse away from or toward 

the centre, while doing one of the following:  

To keep the centre of an object in the same place, hold down CTRL while dragging the mouse.  

To maintain the object's proportions, drag one of the corner sizing handles.  

To maintain the proportions while keeping the center in the same place, hold down CTRL while 

dragging one of the corner sizing handles.  

 

Crop a picture  
1. Select the picture you want to crop.  

2. On the Picture toolbar, click Crop . 

3. Position the cropping tool over a cropping handle and then do one of the following:  

To crop one side, drag the center handle on that side inward. To crop equally on two sides at 

once, hold down CTRL as you drag the center handle on either side inward.  

To crop equally on all four sides at once, hold down CTRL as you drag a corner handle inward.  

4. On the Picture toolbar, click Crop to turn off the Crop command.  

Text Box:  

1. On the Drawing toolbar, click Text Box . 

2. Click or drag in your document where you want to insert the text box  

3. You can use the options on the Drawing toolbar to enhance a text box—for example, to 

change the fill color— just as you can with any other drawing object  

Paragraphs: Change line spacing  
Select the text you want to change.  

1. On the Formatting toolbar, point to Line Spacing, and then do one of the following:  

To apply a new setting, click the arrow, and then select the number that you want.  

To apply the most recently used setting, click the button.  

To set more precise measurements, click the arrow, click More,  and then select the options you 

want under Line Spacing.  

Change spacing before or after paragraphs  

1. Select the paragraphs in which you want to change spacing.  

2. On the Format menu, click Paragraph, and then click the Indents and  Spacing tab.  

3. Under Spacing, enter the spacing you want in the Before or After box.  

Change paragraph direction  

Place the insertion point in the paragraph that you want to change, or select several paragraphs. 

2. Do one of the following:  

To have text begin from the left, click Left-to-Right on the Formatting toolbar.  

To have text begin from the right, click Right-to-Left on the Formatting toolbar.  

When you change the paragraph direction, Microsoft Word leaves justified and centred text as it 

is. In the case of left-aligned or right -aligned text, Word flips the alignment to its opposite. For 
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example, if you have a left-to-right paragraph that is right aligned, such as the date at the top of a 

letter, clicking Right-to-Left results in a right-to-left paragraph that is left aligned.  

Forms: Using Microsoft word one can create an organized and structured document with a 

provision to enter the required information into it. A document of such nature is called a form.  

Mail Merge: It helps us to produce from letters mailing labels envelopes catalogues and others 

types of merged document. It is so found in the tools option on the menu bar. In tools we have 

letters and mailing. In letters and mailing we have mail merge mail merge tool box envelopes 

tables and letters wizard. In mail merge select the required document you are working on. A 

window for customizing the data base structure appears. This file contains the names, address 

details with contact numbers etc of people you wish to send the letters.  

Inserting objects: Insert an object such as drawing word art text effects or an equation at the 

inserting point.  

Fields: It inserts a field at the inserting font fields are used to insert a variety of information 

automatically. Select table in table select insert. In that select insert table a box containing 

number of rows and columns will appear. Select six colors and four rows and click o.k. Given 

the first row as date, problem repeated student‘s signature action recommended problem status 

and councillors sign. Insert the objects in the feedback form and apply the text fields in the form.  

PROCEDURE:  

Mail Merge:  
1. Open a document and type the complete body of the letter and format it as required.  

2. Create a data source and choose mail merge from tool bar a window is displayed.  

3. Click on create button and choose from letter options. Then a window is displayed.  

4. Click active window choose currently active document. Click on data and create data source 

option.  

5. A window for customizing the data base structure appears and this file contains the names 

address details with contact number etc. we can add or remove fields from this file. 

6. Once the list of fields is finalized a window of same is displayed and types the required file 

names and click on save button.  

7. A window is displayed. Type the details of 10 candidates. After typing details of one person, 

click on add menu.  

8. Click on the o.k. to finish entering the records mail merge tool bar is displayed.  

9. Place the curser at the place where you wish to insert names and click on insert mail merge 

button. A drop list is displayed all fields created would be shown.  

10. By highlighting to desired file and click on it we can insert the field into the main document 

and go to begin the mail merge click on mail merge.  

11. A window is displayed click once on the merge button to generate letters for all records in 

your data source file.  

Forms:  

1. Design the form by sketching a layout first, or use an existing form template as a guide. 

Tables, text boxes, borders, and shading are all design elements that can help you create a well-

designed form that's easy to use.  

2. On the Standard toolbar, click New Blank Document . 

3. Add the text or graphics you want. For example, enter the questions you want answered, and 

list the available choices.  

4. To insert a text box where users can enter their responses, click the document, and then click 

Text Form Field on the Forms toolbar. If you need more space, you can insert multiple text 
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boxes side by side. To insert check boxes that list choices, such as Yes and No, click the 

document, and then click Check Box Form Field on the Forms toolbar.  

5. Save the form.  

Insert line numbers:  
1. On the File menu, click Page Setup, and then click the Layout tab.  

2. In the Apply to box, click Whole document.  

3. Click Line Numbers.  

4. Select the Add line numbering check box, and then select the options you want.  

TEST DATA: No Test data for this Experiment  

ERROR: No Errors for this Experiment  

RESULT: A document is created by applying the above mentioned techniques. 
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EXCEL 

Excel Orientation: The mentor needs to tell the importance of MS office or equivalent 

(FOSS) tool Excel as a Spreadsheet tool, give the details of the four tasks and features that 

would be covered in each. Using Excel –Accessing, overview of toolbars, saving excel files, 

Using help and resources. 

Task 1: Creating a Scheduler - Features to be covered: Gridlines, Format Cells, 

Summation, auto fill, Formatting Text 

AIM: To maintain a shift schedule with specifications  

Software Requirement: MS-EXCEL  

Hardware Requirement: Personal computer  

THEORY:  

Grid lines:  
1. Click the worksheet and on the file menu, click page setup and the click the sheet tab.  

2. Click gridlines and select the sheets on which you want to change the gridlines color.  

3. On the Tools menu click options click the color you want in the color box.  

4. To use the default gridlines color click automatic.  

5. Lines you can add to a chart that make it easier to view and evaluate data. Gridlines extend 

from the tick marks on an axis across a plot area.  

 

Format Cell:  
1. Change the font and font size and change the text color.  

2. Make selected text or numbers bold, italic or underlined.Create a new style.  

Auto fit:  
1. Combine cells horizontally or vertically to make one large cell.  

2. Add borders to cells. Shade cells with colors.  

3. Change the column width and row height  

4. Change the font, font size or colors of text. Align text vertically at the top, centre and bottom 

of cell.  

Formatting the text:  
1. Select the text you want to format.  

2. On the format menu click cells and then click number tab. In the catalog box click text.  

3. Enter the numbers in the formatted cells.Clickok.Then press enter and renter the data.  

PROCEDURE:  
First click start button of the screen on status bar. Click on programs and then Microsoft excel. 

To get a new blank work sheet go to programs and then click on excel sheet. On the file menu 

click page setup and then click sheet tab click gridlines. In this way do the required changes 

using format cell, make the required changes using formatting text also make the required 

changes. Enter the data in the data in the worksheet consisting of week name person name and 

timings 7 a.m. to 3 p.m. Make all the above changes to the text.  

TEST DATA: No Test data for this Experiment 

ERROR: No Errors for this Experiment  

RESULT: A Excel Sheet is created by applying the above mentioned techniques  
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Task 2: Calculating GPA - Features to be covered: - Cell Referencing, Formulae in excel – average, 

std. deviation, Charts, Renaming and Inserting worksheets, Hyper linking, Count function, 

LOOKUP/VLOOKUP 

 

AIM: To maintain a control chart for printing books with given data.  

Software Requirement: MS-EXCEL  

Hardware Requirement: Personal computer  

THEORY:  

1. On the chart menu click chart type.  

2. Text direction. Click the arrow down next to the text direction button. For right to left click 

right to left. For left to right reading order, click left to right. For reading order that is consistent 

with the language of the first entered character, click context. For reading order that is 

inconsistent with the language of the first entered character, click control.  

3. In the tools menu click options and then click chart tab.  

4. To show all worksheet data in the chart even if some rows and columns are hidden, clear the 

plot visible cells by check box.  

5. To prevent hidden rows and columns from displaying in the chart, select the  

plot cells only check box.  

Hyper Linking:  
1. Create a worksheet: On the file menu, click new, and then click blank workbook task pane.  

2. Insert a worksheet: C lick worksheet on the insert menu. Right click  

on sheet tab and then click insert double click the template for the type of sheet you want.  

3. Hyperlink: Using hyperlink we can insert one more sheet in the present sheet  

4. Count function: Create a blank worksheet press control +c. In the worksheet select cell A and 

press control +c. On the tools menu point to formula auditing and then click formula auditing 

menu.  

Worksheet:  
1. In the file menu go to menu then a new worksheet is created.  

2 To add a single worksheet, click worksheet on the Insert menu. To add multiple worksheets 

hold down shift and then click the number of worksheet tasks to add in an open workbook.  

Sort:  
1. Click a cell in the list you want to sort.  

2. On the Data menu click sort.  

3. Under first key sort click the custom sort order you want and then click ok. 

4. Click any other sorting option you want.  

PROCEDURE:  

Formulae in Excel:  

First click on start button at the bottom of the screen on status bar. Click on programs and then 

on Microsoft excel. Then open a new document. Give the main heading and subheading by 

changing the size so that they look in block letters. Enter the data. To calculate go to Insert menu 

in the menu bar and then click on function and then ok. Then select the data to which you want 

to calculate mean. Then you get the required answer. In same way, sample means standard 

deviation lower count limit and upper count limit. Go to insert menu and click on function and 

select the required operation to be done and select the data and calculate. Formulas for all the 

above are given below.  

Mean = (s1 + s2 + s3 + s4 + s5)/5;  

Sample mean = avg (mean)  
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Standard deviation = (mean, sample, mean)  

Sample standard deviation= avg (Standard deviation)  

Lower count limit = sample mean – sample standard deviation.  

Upper count limit = Sample mean + Sample Standard deviation  

Count Function  
Some of the content in this topic may not be applicable to some languages.  

1. To count words in selected text only, select the text you want. If you don't select any text, 

Microsoft Word counts the words in the whole document.  

2. On the Tools menu, click Word Count. Word displays counts for words, paragraphs, lines, 

and characters.  

3. To add or remove footnotes and endnotes from the count, select or clear they Include 

footnotes and endnotes check box.  

VLOOKUP and HLOOKUP Functions  
This document explains the functions of VLOOKUP and HLOOKUP and how  

to use them in a spreadsheet. It can be used in all versions of Microsoft Excel.  

VLOOKUP and HLOOKUP are functions in Excel that allow you to search a table of data and 

based on what the user has supplied and give appropriate  

information from that table.  

If you have a table of Student ID numbers, Student Names and Grades, you can set up Excel so 

that if a Student ID number is supplied by the user, it will look through the table and output the 

student's name and grade. 

 
VLOOKUP allows you to search a table that is set up vertically. That is, all of the data is set up 

in columns and each column is responsible for one kind of data. In the Student Record example, 

there would be a separate column of data for Student Names, one for Student ID numbers, etc.  

HLOOKUP is the exact same function, but looks up data that has been formatted by rows instead 

of columns.  
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The format of the VLOOKUP function is:  

VLOOKUP (lookup _value, table _array, col _index _num, range _lookup) The lookup _value 

is the user input. This is the value that the function uses to search on. If you are searching a table 

by the Student ID number, then the lookup _value is the cell that contains the inputted Student 

ID number being looked up.  

The table _array is the area of cells in which the table is located. This includes not only the 

column being searched on, but the data columns for which you are going to get the values that 

you need. Back to the example, the table_array would not only include the Student ID number 

column, but the columns for the Student Names and Grades as well.  

The col _index _numis the column of data that contains the answer that you  

want. If your table is set up as: column 1 - Student ID Number, column 2 - Student Names, 

column 3 - Grades and you inputted a Student ID Number and  

you want to retrieve the grade that was received for that person, the col _index  

_num would be 3. 3 is the column number of the data column for the ANSWER  

that you are trying to look up.  

Range _lookup is a TRUE or FALSE value. When set to TRUE, the lookup function gives the 

closest match to the lookup _value without going over the lookup _value. When set to FALSE, 

an exact match must be found to the lookup _value or the function will return #N/A. Note, this 

requires that the column containing the lookup _value be formatted in ascending order.  

To use the Function Wizard to insert a VLOOKUP function:  

1. Select the cell that will contain the answer to the VLOOKUP and select  

Insert ->Function...  

2. Under the Function Category, choose either All or Lookup & Reference.  

3. Under the Function Name, select VLOOKUP, and hit OK. 

 

4. The Function Wizard for VLOOKUP will then display. The 4 values  

talked about above (lookup_value,table_array,col_index_num, range_lookup) are required by the 

function. Each line for each value required. If you put the cursor into the first line for lookup 

down below it explains what the lookup Similar information is displayed when the cursor is in 

any of the other fields. 
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5. Enter in the lookup _value either by typing in by selecting the cell on the worksheet.  

6. Enter in the table _array by typing in the numbers for the cells, or, by selecting the group of 

cells on the worksheet.  

7. Enter in the number for column which contains the data that you obtain in the col _index 

_num area.  

8. Enter into the range _lookup field the value TRUE if the function should accept the closest 

value to your lookup _value without going over or FALSE if an exact match is required. Hit OK 

when ready.  

TEST DATA: No Test data for this Experiment  

ERROR: No Errors for this Experiment  

RESULT: An Excel Sheet is created by applying the above mentioned Techniques. 
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 POWERPOINT 

Task 1: Students will be working on basic power point utilities and tools which help them 

create basic PowerPoint presentations. PPT Orientation, Slide Layouts, Inserting Text, 

Word Art, Formatting Text, Bullets and Numbering, Auto Shapes, Lines and Arrows in 

PowerPoint. 

AIM: To maintain a PowerPoint presentation with some specifications  

THEORY:  

SLIDE LAYOUT:  
1. On the format menu, click slide layout.  

2. On the slides tab in normal view, select the slides; you want to apply a layout too.  

3. In the slide layout task pane, point to layout you and then click it.  

4. A new slide can also be inserted within the task pane. Point the layout you want the slide to 

have, click the arrow and then click the insert new slide.  

INSERT TEXT:  
1. Text can be added to layout.  

2. Align text in the top, middle or bottom of a cell.  

3. Align text on the right or left, or in the centre of a cell.  

4. Change cell margins.  

5. Insert a tab in a table.  

6. To make the symbol command available, in normal view, place the  

Insertion point on the outbox tab or in a text place holders on the slide.  

7. On the insert menu, click symbol.  

8. To change fonts, click a name in the font box.  

FORMATTING TEXT:  
1. Select the text you want to format as superscript or subscript.  

2. On the format menu, click font.  

3. To show or hide text formatting, on the standard toolbar, click show formatting. 

BULLETS AND NUMBERINGS:  

1. Select the lines of text that you want to add bullets or numbering to.  

2. Click bullets or numbering.  

AUTOSHAPES:  
1. Select the auto shape that has the text you want to position.  

2. Double-click the selection rectangle of the auto shape or text box and then click the text box 

tab in the format dialog box.  

3. In the text anchor point box, click the position you want the text to start in.  

LINES AND ARROWS:  

1. In Microsoft power point, double click the chart.  

2. Double click the chart item you want to change.  

3. On the patterns tab, do one or both of the following.  

4. To change the colors, patterns or lines, select the options you want.  

5. To specify a fill effect, click fill effect and then select the options you want on the gradient, 

text patterns or picture tabs. To return to the slide, click outside the about  

PROCEDURE:  
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First click on start button at the button of the screen on status bar. Click on programs and then 

Microsoft PowerPoint. Go to file and new. Then you find different pattern of slides on right side 

of your screen. Then select which is completely empty. Then enter the contents in the first slide 

as per given information, name in the second slide, Address in the third slide, Hobbies in the 

fourth slide and friends in the fifth slide. Except first slide, all the second, third, fourth, fifth 

slides should be inserted. When you select pattern of slide from a new slide, on slide which you 

selected you will find an arrow towards its right side, click that arrow and then again click insert 

slide. Then save it. Then adjust the layout. Then format the text then give bullets or numbering to 

the text if required. Go to auto shapes. Select more auto shapes and insert wherever required. 

Then again go to insert option and select new slides. And select chart and a chart with datasheet 

appear. Give the name, roll no, marks in three subjects and calculate the total. Then save the file.  

TEST DATA: No Test data for this Experiment  

ERROR: No Errors for this Experiment  

RESULT: A Power point Presentation is created by applying the above  

Mentioned techniques. 
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Task 2: Interactive presentations - Hyperlinks, Inserting –Images, Clip Art, Audio, Video, 

Objects, Tables and Charts. 

AIM: To maintain a PowerPoint presentation using some specifications  

THEORY:  

HYPERLINK:  
1. Select the text or object that you want to represent the hyperlink.  

2. Click insert hyperlink.  

3. Under link to, click place in this document.  

INSERT IMAGES: 

1. Click where you want to insert the picture.  

2. On the drawing tool bar, click insert picture.  

3. Locate the folder that contains the picture that you want to insert, and  

then click the picture file.  

CLIP ART:  
1. On the insert menu, point to structure and then click clipart.  

2. In the clipart task pane, in the search for box, type a word or phrase that describes the clip, you 

want to type in all or some of the file menus of the clip.  

3. In the results box, click the clip to insert it.  

AUDIO VIDEO OBJECTS:  

1. On the slide show menu, click setup show. Under performance check box. If your computer 

has their capability, office PowerPoint will attempt to use it.  

2. Animation performance will be much better with a video card that has Microsoft directs 3D.  

CHART:  

1. Click the slide where you want to place the embedded object.  

2. On the insert menu, click chart.  

3. Click a cell on the data sheet and then type the information you want .To return to the slide, 

click outside the chart  

PROCEDURE:  
First click on start button at the bottom of the screen on status bar. Click on programs and then 

Microsoft power point goes to file menu. Then you find different pattern of slides on right side of 

your screen. Then select which is completely empty. Then enter the name of your college in bold 

letters. Address of your college in bold letters in the second slide. List of all the available courses 

in the third slide, extra co-curricular activities in the fourth slide except first slide, all the second, 

third, fourth slide should be inserted. When you select pattern of slide from a new slide, on slide 

which you selected, you will find an arrow towards it right side click that arrow and then again 

click insert slide. Then save it the select the slide show and then select the view show option. 

Then review the presentation in slide show by selecting next and after completing the slide show 

then click end show. Click on start button at the button of the screen on status bar, click on 

programs and then Microsoft power point. Go to file menu. On insert menu and select table 

option and give no. of rows and no. of columns and give the name, Roll no and marks in three 

subjects and find the total  

TEST DATA: No Test data for this Experiment  

ERROR: No Errors for this Experiment  

RESULT: A Power Point Presentation is created by applying the above mentioned techniques. 
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AIM: Create a Document by Using Latex 

PROCEDURE: 

 CODE: 

 
\documentclass{article}  
\usepackage{amsmath}  
\usepackage{amsfonts}  
\usepackage{amssymb}  
\usepackage{graphicx}  
\centering  
\title{OPERATING SYSTEMS } 
\begin{document}  
\section{OPERATING SYSTEMS}  
\subsection{Introduction}  
Operating systems are the software that manages the hardware and software resources of a computer. 
They are responsible for allocating resources, managing memory, and providing a user interface. In this 
document, we will discuss the different types of operating systems, their functions, and how they work.  
\subsubsection{Types of Operating Systems}  
There are several types of operating systems, including:  
\begin{itemize}  
\item Single User Operating Systems: These operating systems are designed to run on a single computer 
and provide a single user interface. Examples include Windows and MacOS.  
\item Multi-User Operating Systems: These operating systems allow multiple users to access the same 
computer at the same time. Examples include Unix, Linux, and Solaris.  
\item Distributed Operating Systems: These operating systems allow multiple computers to work 
together as a single system. Examples include Cloud Computing and Grid Computing.  
\item Real-Time Operating Systems: These operating systems are designed to respond to events in real-
time. Examples include embedded systems and robotics systems.  
\end{itemize}  
\begin{figure}[h]  
\centering  
\includegraphics[width=0.5\textwidth]{Picture2.jpg}  
\caption{EVOLUTION OF WINDOWS OPERATING SYSTEM}  
\label{fig:os-image}  
\end{figure}  
\end{document} 
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OUTPUT:  

 


